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1. MetaTrade 4 Interface 

 
1. Main menu                  > Access to the program menu and settings 
2. Toolbars                            > Quick access to the program features and settings 
3. “Market Watch” Window    > Real-time quotes for the specified instruments 
4. “Navigator” window             > Quick access to your accounts, indicators, expert advisors 
5. “Terminal” window              > Quick access to the trading and account history, list of open positions and placed orders, client terminal  
                                                         Log-file and internal mailbox. 
6. “Chart” window                    > Chart display for analysis  
  

  
1. Main menu 

2. Toolbars 

3. “Market Watch” Window 

4.”Navigator” window 

5. “Terminal” window 

6.”Chart” window 
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2. Trading Instrument 

Tools > New Order  View > Toolbars > Standard > New Order 
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2. Trading Instrument 

Market Watch – Symbol List Market Watch – Symbol List 
> Right click             > Right click two times   
> New order 
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2. Trading Instrument 
 

             Market Watch – Symbol List      Market Watch – Symbol List 

             > Right click      > Right click  

             > Choose Popup Prices      > Choose Popup Prices 

             > Double click      > Double click 
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2. Trading Instrument 
 
Right click on the chart 
Trading > New Order  
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2. Trading Instrument 
 
Trade          Terminal > Trade > Right Click on Order 
> Right Click        > Choose New order/Close order/Modify or Delete order 
> New Order 
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3. Trading Categories  
 

             1. Trading Product > Forex and Commodities 

 2. Type > Market Execution and Pending order 

 3. Lot Size > 1 lot is 100 ounces for Gold, 1 lot is 5000 ounces for Silver, 1 lot is 100,000 unit for Forex 

  



 
 

9 | CHARTERPRIME MT4 User Guide 
 
 

 

4. Trading – Market Execution (Modify Order) 

 
After new order, right click on the order 
> Choose Modify or Delete Order 
> Modify Stop loss/Take Profit 
> Copy as > Copy according to market price movement for stop loss and take profit  
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4. Trading – Pending Order 

There are 4 types of Pending Order      4 types of Pending Order 
> Buy Limit, Sell Limit 
> Buy Stop, Sell Stop 
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4. Trading – Pending Order (Buy Limit) 

 Buy Limit 

 > Market Price: 1.556879, 1.56914 

 > Price: 1.56896 (<=1.56896) 

 > Stop Loss: 1.56915 (<=1.56915) 

 > Take Profit: 1.56914 (>=1.56914) 
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4. Trading – Pending Order (Sell Limit) 

 Sell Limit 

 > Market Price: 1.56939, 1.56952 

 > Price: 1.56896 (<=1.56896) 

 > Stop Loss: 1.56915 (<=1.56915) 

 > Take Profit: 1.56914 (>=1.56914) 
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4. Trading – Pending Order (Buy Stop) 

 > Market Price: 1.56889, 1.56907 

 > Price: 1.56896 (<=1.56896) 

 > Stop Loss: 1.56915 (<=1.56915) 

 > Take Profit: 1.56914 (>=1.56914) 
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4. Trading – Pending Order (Sell Stop) 

 > Market Price: 1.56633, 1.56648 

 > Price: 1.56896 (<=1.56896) 

 > Stop Loss: 1.56915 (<=1.56915) 

 > Take Profit: 1.56914 (>=1.56914) 

 

  



 
 

15 | CHARTERPRIME MT4 User Guide 
 
 

4. Trading – Delete Order 

 Method 1 – Right Click on the order     Method 2 - Double Click on the Order 

 > Choose Modify or Delete Order     > Double Click on the order 

 > Click on Delete Order to cancel the order    > Select Close Order  
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4. Trading – Delete Order  

  Method 3 – Click X on the right corner 
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5. Stop-loss Position 

 Trailing Stop: is an algorithm to manage Stop Loss orders. Once a trailing stop has been placed (for example, trailing stop’s value is 

 15 pips) the following occurs: 

 No Stop Loss order will be placed until the open position is in a profit of at least 15 pips. MetaTrader 4 then sends an instruction to 

 place the Stop Loss order 15 pips higher or lower than the current price. 

 Subsequently, each time the difference between the current price and the order level exceeds.  

 15 pips, MetaTrader 4 sends the instruction to modify the Stop Loss order to a level 15 pips higher or lower than the current price. 

 As a result, the Stop Loss order becomes closer to the current price. 

  

Important:  

 It is very important to take note that no Stop Loss order will be placed until the market moves in your favour as mentioned above.  

 Therefore until this has happened, to limit losses, you will need to place a separate Stop Loss manually. 
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 In order to place a trailing stop, highlight the open position in the “Trade” tab of the “Terminal” window and right click to open the 

 Context menu.  
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6. Chart 

 3 type of Charts 

 

 

 

         Line Chart                 Bar Chart                     Candle Sticks 

 

In order to change the chart, press button on the toolbar, or press Alt+1 for Bar chart, Alt+2 for Candlesticks or Alt+3           

for Line Chart. 
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7. File 

 New Chart 

 > Open new chart  

 Open Offline 

 > Open saved history data in computer 

 Open Deleted 

 > Reopen closed chart 

 Profiles 

 > Save preferred charts, indicators and time frame across all the charts 

 Close 

 > Close chart 

 Save As 

 > Save history data (CSV file) 

 Save As Picture 

 > Save data as Picture 

 Print 

 > Print chart 
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8. View – Market Watch - Symbols 

 Right click on Symbols  

New order – enables the window to open/close a position or to place a new pending order. 

 Chart Window – displays the chart of a currency pair or CFD. 

 Tick Chart – shows the tick chart in position of market watch window for selected pair. 

 Depth of Market – open the depth of the symbol selected. 

 Specification – open symbol parameters 

 Hide – removes the specified symbol from the list in the “Market Watch” window. 

Hide All – removes all symbols from the list in the “Market Watch” window which are not 
used (if you have open positions or charts, its symbols will not be deleted); 

Show All – displays all available symbols in the “Market Watch” window; 

Symbols – enables the window where you can hide/show the selected instruments; 

Sets – open the sub-menu that manages the symbol sets  

Spread – show/hide column that displays spread (the difference between the bid and ask 
prices) 

High/Low – shows/hides columns with the highest and lowest prices for each instrument; 

Time – displays a column with the arrival time of the latest quote for each instrument; 

Grid – hides/unhide gridlines in the “Market Watch” window; 

Popup Prices – opens the popup window which contains real time quotes for your selected instruments.  
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8. View – Market Watch – Popup Prices 

 Popup Prices – open an additional quotes window. You can also open this window 

 by pressing F10 on your keyboard. The list of symbols in this window is the same as  

 the ones in the “Market Watch” window at the moment of the command execution. 

 This means that changes in the symbol list in the “Market Watch” window does not   

influence the “Popup Prices”, It is an information window, but trading  

 operations can also be performed from it. To do so, double-click with the left mouse 

 on the desired security. In the context menu of this window, there are commands  

 allowing to set up data displaying parameters, enable the full screen mode, or  

 locate the window over all others 
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8. View – Market Watch – Tick Chart 

To view the tick chart of an instrument, select a symbol in the “Symbols” 

tab of the Market Watch and switch to the “Ticks” tab. 

New Order – To open/close a position or to place a new pending order. 

Chart Window – Displays the chart of a currency pair or CFD. 

Ask Line – Hides/unhide asklines in Tick Chart window. 

Grid - Hides/unhide gridlines in the Tick Chart window.  
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8. View – Data Window 

             DATA is a window that unfolds information about opening price, closing price, maximum and minimum of a Candlestick, time and date. 

            It can also show Forex Indicator data that are managed on the actual chart. To get this info from a specific Candlestick, you just have to  

            set the pointer over it.                

         

RIGHT CLICK ON THE MOUSE: 

 COPY - Copy data from this window into the clipboard for further use in 
other applications. 
 

 LAST DATA- Show/hide the latest data column. At that, an additional 
column containing the last bar data will appear in the window. 

 
 

 AUTO ARRANGE- Set up the column size automatically when the 
window size changes.  
 

 GRID - Show/hide grid to separate columns. 
 

 
 SHOW- Show/hide information fields. Any of the bar prices (OHLC), date 

or volume can be selected in the sub-menu that appears. If the element 
has not been checked, it will not be shown. 
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8. View – Navigator 

             The Navigator window provides quick access to the specific components of your accounts. 

             Technical Indicators can be pulled directly into the chart using LEFT MOUSE BUTTON.  

 

  

• Accounts – Any accounts that you have created, both demo 
and live, will be displayed in this section. Each account can be 
logged into from this point and can be modified through a 
drop down menu by right clicking. 

• Indicators – Access to a wide variety of technical indicators 
that can be added to a chart window. 

• Expert Advisors – Provide a list of automated strategies 
that analyse market trends and place trades based on pre 
specified criteria. 

• Custom Indicators – Includes a list of any trader-modified 
indicators that have been added or created by the account 
holder. 

• Scripts – Access to programs that perform a single trading 

action once. 
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RIGHT CLICK ON THE MOUSE: 

 Attached to the chart – Displayed in the chart. 
 Add to favorites – Customer favorites commonly used indicators up. 
 Setting Shortcuts 
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8. View – Terminal Tabs 

              

 

 

 

 

 

 

 

 

 

 

  

 Trade – Displays open positions, pending orders, account balance, and free margin Account. 

 Account History – List of all executed trades, view profit and loss, credits, volume, etc. 

 News – All financial news incoming in the terminal can be viewed from this tab. 

 Alerts – Various alerts can be viewed and set here. Any files executable in the operational environment (including 
wave files) and messages to be sent by email can be used as alerts. 

 Mailbox – All message income in the terminal by internal email are stored here. Electronic messages are sent from 
here, as well. 

 Market- Buying or downloading applications from the market of MQL4 applications at MQL5.community website. 

 Code Base- Download applications published in the ‘Code Base’ section of the MQL5.community website. 

 Experts – Includes all expert advisors that have been activated on the account, whilst also providing access to account 
history relative to Expert advisors. 

 Journal – Display of system messages relating to your account, including log in status and orders placed, modified or 
closed. 
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                          UNDER THE TRADE TAB, THERE IS A ROW DISPLAYING: 

                      

 

 

 

 

 

 

 

 

  

 

 Balance: The amount of balance in the account. This does not take into account the Floating P/L of any 

positions held, and it is only reflected to the Balance once the positions are closed and the P/L’s are realized. 

 Equity: The total amount of cash in the account and the equity which takes into account the current floating 

value of those positions held. In other words, this would be calculated as : Balance- Net Floating P/L 

 Margin: The amount of cash used to open current open positions. 

 Free Margin: The amount of cash available to open new position. This is calculated as Equity- Margin. 

 Margin Level: Proportion of Equity against Margin. This is calculated as Equity/ Margin. 
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8. View – Terminal - Alerts 

               

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

The Alerts can be enabled/ disabled simply by right-

clicking on the alert item and select ENABLE ON/ OFF: 

 

 

 

The Alerts can be created or modified by right clicking anywhere 

on the Alerts tab or the alert item, and select: 

 

 

 



 
 

30 | CHARTERPRIME MT4 User Guide 
 
 

                       Create / Modify:  

                   

 

 

 

 

 

 

 

 

 

 Enable: Selecting this option will enable the alert function. 

 Action: Specifies the action to be taken to notify the user. The options are Sound, File, Mail and 

Notification.  

 Expiration: Date and Time at which the alert function expires. Select the box in the field to activate 

expiration. 

 Symbol: This is the symbol for the instrument for which the alert function will be set on. 

 Condition: This is the condition type in which the alert function will be triggered. The options are: ‘Bid<’ , 

‘Bid>’, ‘Ask<’, ‘Ask>’ and ‘Time=’ 

 Value: This will be the value in which combined with the condition alert function will be triggered. 

 Source: This will be the alert sound source for Sound Action. 

 Timeout: This is the period of time between each alert triggering. 

 Maximum iterations: This is the maximum amount of the time the alert will be triggered repeatedly. 
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8. View – Toolbars 

             Standard Toolbar : Contains tools for displaying windows in the MetaTrader workspace. 

               

              (The functionality of each icon in the toolbar in the order from left to right.) 

 

 

 

 

 

 

 

 

 

 

 

 

1. New Charts- This is to add a chart for any selected symbol from the list. 
2. Profiles- Profile shows a collection of charts on the platform. The default profile will appear on the screen on the 

screen for the first opening of Blackwell Trader. Any changes on the profile will be saved to the Default profile unless 
you are saving as a new profile. 
To create a new profile with changes, click on the SAVE PROFILE AS and create a new profile name. You may create 

and remove profiles however the Default profile cannot be deleted. 

3. Market Watch 
4. Data Window- Select this to make the Data Window appear. Move your cursor to any candle in a chart and available 

data of the candle will be shown in the Data Window. 
5. Navigator 
6. Terminal 
7. Strategy Transfer- This window appears on the bottom of the platform. This is for Expert Advisors testing. 
8. New Order- The Order window will appear on the platform. The symbol selected is taken from the current active 

chart on the platform. 
9. Meta Editor- This opens a new window to edit Expert Advisors, Custom Indicators and Scripts. 
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                                Charts Toolbar: Displays tools for managing the appearance of the chart window. 

                                  

                                (The functionality of each icon in the toolbar in the order from left to right.) 

 

 

 

 

 

 

 

 

 

 

 

 

1. Bar Chart- If selected, it will display the chart using bars.   
2. Candlestick Chart- If selected, it will display the chart using candlesticks. 
3. Line Chart- If selected, it will display the chart as a line graph. 
4. Zoom In- Click to zoom in. 
5. Zoom Out- Click to zoom out. 
6. Auto Scroll- If selected, the latest bar will always show on the screen. To see previous bars, deselect the Auto 

Scroll. 
7. Chart Shift- Select this to shift the chart to the left, allowing more space on the right side of the chart for future 

prediction of trends. 
8. Indicators- You can click this to select any indicators instead of using the Navigator window. 
9. Periodicity- You can choose the time periods for each bar/line to represent:  

M1: 1 minute   M5: 5 minutes   M15: 15 minutes  M30: 30 minutes 
H1: 1 hour   H4: 4 hours   D1: daily   W1: weekly 

MN: monthly 

10. Templates- Click to load, save or delete templates as desired. 
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                   LINE STUDIES- The Line Studies toolbar contains tools for displaying drawing and analytic objects and text in the chart window. 

                         

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

1. Cursor- This is the standard arrow cursor by default for selecting items. 
2. Crosshair- This shows the number of bards, pips and prices at the second point. Press of the two points in a chart. 

Select Crosshair. Move to active chart window and select the first point. Space and hold down left mouse button and 
move to the second point. Line connecting the two points will be drawn and the data shows number of bars/ 
number of pips/ price at the second point. Release the left mouse button and all will disappear. 

3. Vertical Line- Select the icon, place at desires position. To make changes, double click on selected line and handles 
(two small white squares) drag to new position or right click near the line to access line properties to make changes. 
Double click after making changes to remove handles and to place line at a particular time. 

4. Horizontal Line- This works the same as drawing Vertical line. This function is to draw support and resistance levels. 
5. Trend Line- This function is to draw a Slanting or Trend line. Select the Trend Line. Place at the first point, hole down 

left mouse button and select the second point on the line. Trend line will snap to nearest point. Double click to show 
handles to check if a proper point is selected. There are three handles in the Trend line. The middle handle is to 
move the whole line. The two end handles in moveable, so that they snap and attached automatically at the end of a 
handle. 

6. Equidistant Channel- This function is to draw an Equidistant Channel, which represents two parallel lines that 
connect maximum and minimum prices. 

7. Fibonacci Retracement- This function to draw the Fibonacci Retracement object. 
8. Text- Allows text to be written on the chart window.  
9. Text Label- Allow text to be written in the form of a label on the chart window. It works in the same way as the text 

function. 
10.  Arrows- Allows the placement of arrows and other icons on the chart window.  
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             PERIODICITY- The Periodicity toolbar displays tools for managing time frames of the chart window. 

  

 

 M1: 1 Minute 

M5: 5 Minute 

M15: 15 Minutes 

M30: 30 Minutes 

H1: 1 Hour 

H4: 4 Hours 

D1: Daily 

W1: Weekly 

MN: Monthly 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

35 | CHARTERPRIME MT4 User Guide 
 
 

 

8. View – Languages, Toolbars, Status Bar, Charts Bar 

         

 

 

 Languages – Sub-menu managing languages of the Client Terminal. Having selected a 
desired language, one can switch the terminal interface to this language. For the 
changes to take effect, the program must be restarted. 

 Toolbars – Sub- menu managing toolbars. Active toolbars are checked. Selection of a 
toolbar allows to enable or disable it. 
Customize- Allows to assign any buttons for any toolbars. At that, a new window 

containing the list of toolbar elements available. 

Insert, Remove- Allow to add or remove an element from the toolbar. 

Up, Down – define the location of a button in the toolbar. 

Reset- To reset the toolbar to appear as initially 

 Status Bar – Enable or disable status bar located in the lower part of the terminal 
window. This data bar contains (from left to right): menu-managing profiles, time and 
prices of the bar selected, and indicator or server connection and amounts of 
incoming or outgoing traffic. Having pressed on the current profile name, one can 
open the menu managing profiles. One can store or remove profiles in this menu, as 
well as download those previously stored. 
The sub-menu for managing profiles can also be called by the “File – Profiles” menu 

command. 

 Charts Bar- Enable or disable the chart window names (tabs) bar located in the lower 
part of the workspace. Using this bar, one can switch among open charts fast. 
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9. Insert 

  

           

 

 
 

 Indicators- Inserts Technical Indicators. 
 Lines- Inserts Lines. 
 Channels- Inserts Channels. 
 Gann- Inserts Gann elements. 
 Fibonacci- Inserts Fibonacci elements. 
 Shapes- Inserts various Shapes. 
 Arrows- Inserts Arrows. 
 Andrew’s Pitchfork- Insert Andrew’s 

Pitchfork. 
 Cycle Lines- Inserts Cycle Lines. 
 Text- Inserts Texts. 

 Text Label- Inserts Text Labels. 
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10. Charts 

 

 
 

 Indicators List- Displays the currently used Technical Indicators for the active chart in a 
new window. 

 Objects- Control for all the objects on the active chart. 
 Bar Chart- Switches the chart type to the Bar Chart. 
 Candlesticks- Switches the chart type to the Candlesticks. 
 Line Chart- Switches the chart type to the Line Chart. 
 Foreground Chart- The chart would appear in front of all the objects. 
 Periodicity- Switches the Timeframes for the active chart. 
 Template- Controls the Template for the active chart. 
 Refresh- Refreshes the active chart. 
 Grid- Displays the Grid Lines on the active chart. 
 Volumes- Displays the Volumes on the active chart. 
 Auto Scroll- Enables Auto Scroll for the active chart. 
 Chart Shift- Enables Chart Shift for the active chart. 
 Zoom In- Zooms In on the active chart. 
 Zoom Out- Zooms Out on the active chart. 
 Step by Step- Shift the chart by one bar to the left. 
 Properties- Properties for the active chart. 
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11. Tools 

        

 

       

 

 

 

  

 

 

 

 New Order- Opens a new window for placing a New Order. 

 History Center- Opens a new window showing all historical 

data available. 

 Global Variables- Opens a new window for setting Global 

Variables for MT4. 

 MetaQuotes Language Editor- Opens MetaEditor. 

 Options- Opens the Options for MT4. 
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12. Window 

             The window menu contains control over the chart windows on MT4: 

 

 

 

 

 New Window: Opens New Chart Window. 
 Cascade: Cascades the chart windows. 
 Tile Windows: Tiles chart windows in square areas. 
 Tile Horizontally: Tiles chart windows horizontally. 
 Tiles Vertically: Tiles chart windows vertically. 
 Arrange Icons: Arrange icons at the bottom of the window. 
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13. Help 

              The Help menu contains general useful information about MT4: 

                

 

 

  

 

 

 

 Help Topics: Opens MT4 Manual produced by MetaQuotes Software Corp. 

 Technical Analysis: Opens MQL4 Technical Analysis Documentation. 

 Automated Trading Championship: Opens the official website for the 

Automated Trading Championship. 

 Mobile Trading: Opens the official MT4 Mobile App websites. 

 MQL4. Community: Opens various MQL4 websites. 

 MQL5. Community: Opens various MQL5 websites. 

 About: Opens a new About window on MT4. 
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